
 

Visio 2013 Keyboard Shortcuts 

Visio-specific tasks 

Format text 

To do this Press 

Open the Home tab in the ribbon ALT+H 

Open the Text dialog box. F11 

Open the Format task pane. F3 

Use the Snap & Glue features 

To do this Press 

Open the Snap & Glue dialog box. ALT+F9  

Group, rotate, and flip shapes 

To do this Press 

Group the selected shapes. CTRL+G or CTRL+SHIFT+G 

Ungroup shapes in the selected group. CTRL+SHIFT+U 

Bring the selected shape to the front. CTRL+SHIFT+F 

Send the selected shape to the back. CTRL+SHIFT+B 

Rotate the selected shape to the left. CTRL+L 

Rotate the selected shape to the right. CTRL+R 

Flip the selected shape horizontally. CTRL+H 

Flip the selected shape vertically. CTRL+J 

Open the Align Shapes dialog box for the selected shape. F8 

View drawing windows 

To do this Press 

Display the open drawing windows tiled vertically. SHIFT+F7 

Display the open drawing windows tiled horizontally. CTRL+SHIFT+F7 

Display the open drawing windows so that you can see the title of every window. ALT+F7 or CTRL+ALT+F7 

Visio-specific toolbars 

Select tools 

To do this Press 
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Switch the Format Painter tool on or off (  ). CTRL+SHIFT+P 

Select the Pointer Tool (  ). CTRL+1 

Select the Connector tool (  ). CTRL+3 

Select the connection point tool CTRL+SHIFT+1 

Select the text tool (  ). CTRL+2 

Select the text box tool (  ). CTRL+SHIFT+4 

Select the drawing tools 

To do this Press 

Select the Rectangle Tool (  ). CTRL+8 

Select the Ellipse Tool (  ). CTRL+9 

Select the Line Tool (  ). CTRL+6 

Select the Arc Tool (  ). CTRL+7 

Select the Freeform Tool (  ). CTRL+5 

Select the Pencil Tool (  ). CTRL+4 

Crop a picture 

To do this Press 

Select the Crop tool (  ). CTRL+SHIFT+2 

Visio shapes and stencils 

Move from shape to shape in a drawing page 

To do this Press 

Move from shape to shape on the drawing page. A dotted rectangle indicates the shape that has the 

focus. 

 Note   You cannot move to shapes that are protected against selection or on a locked layer. 

TAB 

Move from shape to shape on the drawing page in reverse order. SHIFT+TAB 

Select a shape that has focus. 

 Note   To select multiple shapes, press the TAB key to bring focus to the first shape you want to select, 

and then press ENTER. Hold down SHIFT while you press the TAB key to bring focus to another shape. 

When the focus rectangle is over the shape you want, press ENTER to add that shape to the selection. 

Repeat for each shape you want to select. 

ENTER 

Clear selection of or focus on a shape. ESC 

Switch between text edit mode and shape selection mode on a selected shape. F2 
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Nudge a selected shape. Arrow keys 

Nudge a selected shape 1 pixel at a time. 

 Note   SCROLL LOCK must be turned off. 

SHIFT+Arrow 

keys 

Work with master shapes in a stencil 

To do this Press 

Move between master shapes in a stencil. Arrow keys 

Move to the first master shape in a row of a stencil. HOME 

Move to the last master shape in a row of a stencil. END 

Move to the first master shape in a column of a stencil. PAGE UP 

Move to the last master shape in a column of a stencil. PAGE DOWN 

Copy the selected master shapes to the Clipboard. CTRL+C 

Paste the contents of the Clipboard to a new stencil. 

 Note   The new stencil must first be opened for editing. 

CTRL+V 

Select all the master shapes in a stencil. 

 Note   To select multiple master shapes, press the arrow keys to bring focus to the first master shape you 

want. Hold down SHIFT while you press the arrow keys to bring focus to another master. When the focus 

rectangle is over the master you want, press ENTER to add that master to the selection. Repeat for each 

master you want to select. 

CTRL+A 

Select or cancel selection of a master shape that has focus. SHIFT+ENTER 

Cancel the selection of master shapes in a stencil. ESC 

Insert the selected master shapes into the drawing. CTRL+ENTER 

Work with stencils in edit mode 

To do this Press 

Delete the selected master shape. DELETE 

Cut the selected master shape from the custom stencil and put it on the Clipboard. CTRL+X 

Rename the selected master shape. F2 

Online Help 

Keyboard shortcuts for using the Help window 

The Help window provides access to all Office Help content. The Help window displays topics and other Help content. 

In the Help window 

To do this Press 
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Open the Help window. F1 

Close the Help window. ALT+F4 

Switch between the Help window and the active program. ALT+TAB 

Go back to Microsoft Visio 2010 Home. ALT+HOME 

Select the next item in the Help window. TAB 

Select the previous item in the Help window. SHIFT+TAB 

Perform the action for the selected item. ENTER 

Select the next hidden text or hyperlink, including Show All or Hide All at the top of a topic. TAB 

Select the previous hidden text or hyperlink. SHIFT+TAB 

Perform the action for the selected Show All, Hide All, hidden text, or hyperlink. ENTER 

Move back to the previous Help topic (Back button). ALT+LEFT ARROW  

Move forward to the next Help topic (Forward button). ALT+RIGHT ARROW 

Scroll small amounts up or down, respectively, within the currently displayed Help topic. UP ARROW or DOWN 

ARROW 

Scroll larger amounts up or down, respectively, within the currently displayed Help topic. PAGE UP or PAGE 

DOWN 

Display a menu of commands for the Help window. This requires that the Help window have the 

active focus (click in the Help window). 

SHIFT+F10 

Stop the last action (Stop button). ESC 

Refresh the window (Refresh button). F5 

Switch among areas in the Help window; for example, switch between the toolbar, address bar, 

and Search list. 

F6 

In a Table of Contents in tree view, select the next or previous item, respectively. UP ARROW or DOWN 

ARROW 

In a Table of Contents in tree view, expand or collapse the selected item, respectively. LEFT ARROW or RIGHT 

ARROW 

Microsoft Office basics 

Display and use windows 

To do this Press 

Switch to the next window. ALT+TAB 

Close the active window. ALT+F4 

Move to a task pane from another pane in the program window (clockwise direction). You 

may need to press F6 more than once.  

F6 
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 Note   If pressing F6 does not display the task pane you want, try pressing ALT to put focus 

on the ribbon. 

Maximize a selected window. CTRL+F10 

Restore the size of the Visio program window after you maximized it. CTRL+F5 

Copy a picture of the screen to the Clipboard. PRINT SCREEN 

Copy a picture of the selected window to the Clipboard. ALT+PRINT SCREEN 

For any window with an icon in its title bar (for example, a shapes window), display the 

window shortcut menu. 

ALT+SPACEBAR 

Open the Page dialog box. SHIFT+F4 

Open the Reorder Pages dialog box. CTRL+ALT+P 

Cycle the focus through open drawings. CTRL+TAB or CTRL+F6 

Cycle the focus through open drawings in reverse order. CTRL+SHIFT+TAB or 

CTRL+SHIFT+F6 

Cycle the focus through pages in a drawing, including any visible markup overlays. CTRL+PAGE DOWN  

Cycle the focus through pages in a drawing in reverse order. CTRL+PAGE UP  

When a task pane is active, select the next or previous option in the task pane. TAB or SHIFT+TAB 

Change or resize the font 

To do this Press 

Increase the font size of the selected text. CTRL+SHIFT+> 

Decrease the font size of the selected text. CTRL+SHIFT+< 

Move around in text or cells 

To do this Press 

Move one character to the left. LEFT ARROW 

Move one character to the right. RIGHT ARROW 

Move one line up. UP ARROW 

Move one line down. DOWN ARROW 

Move one word to the left. CTRL+LEFT ARROW 

Move one word to the right. CTRL+RIGHT ARROW 

Move to the end of a line. END 

Move to the beginning of a line. HOME 

Move up one paragraph. CTRL+UP ARROW 

Move down one paragraph. CTRL+DOWN ARROW 
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Move to the end of a text box. CTRL+END 

Move to the beginning of a text box. CTRL+HOME 

Access and use task panes 

To do this Press 

Move to a task pane from another pane in the program window. (You may need to press F6 more 

than once.) 

 Note   If pressing F6 does not display the task pane you want, try pressing ALT to put the focus on 

the ribbon and then pressing F6 to move to the task pane. 

F6 

When a task pane is active, select the next or previous option in the task pane. TAB or SHIFT+TAB 

Move among choices on a selected submenu; move among certain options in a group of options in 

a dialog box. 

DOWN ARROW or UP 

ARROW 

Open the selected menu, or perform the action assigned to the selected button. SPACEBAR or ENTER 

Open a shortcut menu SHIFT+F10 

When a menu or submenu is visible, select the first or last command, respectively, on the menu or 

submenu. 

HOME or END 

Float or anchor task panes 

Press F6 repeatedly to select the task pane that you want. 

Press ALT+SPACEBAR to open the menu for that task pane. 

Press the DOWN ARROW key to select the Float Window command, and then press ENTER. 

Use dialog boxes 

To do this Press 

Move to the next option or option group. TAB 

Move to the previous option or option group. SHIFT+TAB 

Switch to the next tab in a dialog box.  CTRL+TAB 

Switch to the previous tab in a dialog box. CTRL+SHIFT+TAB 

Move between options in an open drop-down list, or between options in a group 

of options. 

Arrow keys 

Perform the action assigned to the selected button; select or clear the selected 

check box. 

SPACEBAR 

Open the list if it is closed and move to that option in the list. First letter of an option in a drop-down 

list 

Select an option; select or clear a check box. ALT+ the letter underlined in an option 

Open a selected drop-down list. ALT+DOWN ARROW 
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Close a selected drop-down list; cancel a command and close a dialog box. ESC 

Perform the action assigned to a default button in a dialog box. ENTER 

Use edit boxes within dialog boxes 

An edit box is a blank in which you type or paste an entry, such as your user name or the path of a folder. 

To do this Press 

Move to the beginning of the entry. HOME 

Move to the end of the entry. END 

Move one character to the left or right. LEFT ARROW or RIGHT ARROW 

Move one word to the left. CTRL+LEFT ARROW 

Move one word to the right. CTRL+RIGHT ARROW 

Select or cancel selection one character to the left. SHIFT+LEFT ARROW 

Select or cancel selection one character to the right. SHIFT+RIGHT ARROW 

Select or cancel selection one word to the left. CTRL+SHIFT+LEFT ARROW 

Select or cancel selection one word to the right. CTRL+SHIFT+RIGHT ARROW 

Select from the insertion point to the beginning of the entry. SHIFT+HOME 

Select from the insertion point to the end of the entry. SHIFT+END 

Use the Open and Save As dialog boxes 

To do this Press 

Move to the next option or option group. TAB 

Move to the previous option or option group. SHIFT+TAB 

Move between options in an open drop-down list, or between options in a group of options. Arrow keys 

Perform the action assigned to the selected button ENTER, SPACEBAR 

Move to the Save as type list in the Save As dialog box ALT+T 

Move to the File name box ALT+N 

Move to the file type list in the Open dialog box ALT+T 

Open a selected file in the Open dialog box ALT+O 

Save the current file in the Save dialog box ALT+S 

Open a selected drop-down list. ALT+DOWN ARROW 

Close a selected drop-down list; cancel a command and close a dialog box. ESC 

Update the file list F5 

Display a shortcut menu for a selected item such as a folder or file SHIFT+F10 
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Text 

Edit text 

To do this Press 

Move to the next or previous character, respectively, in a line of text. RIGHT ARROW or LEFT ARROW 

Move to the next or previous line of text, respectively. DOWN ARROW or UP ARROW 

Move to the next or previous word, respectively, in a line of text. CTRL+RIGHT ARROW or CTRL+LEFT 

ARROW 

Move to the next or previous paragraph, respectively. CTRL+DOWN ARROW or CTRL+UP 

ARROW 

Select all the text in a text block. CTRL+A 

Select the next or previous character, respectively. SHIFT+RIGHT ARROW or SHIFT+LEFT 

ARROW 

Select the next or previous word, respectively. CTRL+SHIFT+RIGHT ARROW or 

CTRL+SHIFT+LEFT ARROW 

Select the next or previous line, respectively. SHIFT+DOWN ARROW or SHIFT+UP 

ARROW 

Select the next or previous paragraph, respectively. CTRL+SHIFT+DOWN ARROW or 

CTRL+SHIFT+UP ARROW 

Delete the previous word. CTRL+BACKSPACE 

Replace the selected text with the field height. If no text is selected, replace all 

text with the field height for the selected shape. 

CTRL+SHIFT+H 

Format text 

To do this Press 

Turn bold (  ) on or off. CTRL+B 

Turn italic (  ) on or off. CTRL+I 

Turn underline (  ) on or off. CTRL+U 

Turn double underline on or off. CTRL+SHIFT+D 

Turn all caps on or off. CTRL+SHIFT+A 

Turn small caps on or off. CTRL+SHIFT+K 

Turn subscript (  ) on or off. CTRL+= 

Turn superscript (  ) on or off. CTRL+SHIFT+= 

Increase the font size of the selected text. CTRL+SHIFT+> 

javascript:ToggleDiv('divExpCollAsst_805836366')
javascript:ToggleDiv('divExpCollAsst_743443842')
javascript:ToggleDiv('divExpCollAsst_805836366')
javascript:ToggleDiv('divExpCollAsst_743443842')


 

Decrease the font size of the selected text. CTRL+SHIFT+< 

Align text 

To do this Press 

Align text left. CTRL+SHIFT+L 

Center text horizontally. CTRL+SHIFT+C 

Align text right. CTRL+SHIFT+R 

Justify text horizontally. CTRL+SHIFT+J 

Top-align text vertically. CTRL+SHIFT+T 

Center text vertically. CTRL+SHIFT+M 

Bottom-align text vertically. CTRL+SHIFT+V 

Zoom and navigation 

Navigate the Ribbon 

Press ALT. 

The KeyTips are displayed over each feature that is available in the current view.  

 

Press the letter shown in the KeyTip over the feature that you want to use. 

Depending on which letter you press, you may be shown additional KeyTips. For example, if the Home tab is active and 

you press N, the Insert tab is displayed, along with the KeyTips for the groups on that tab. 

Continue pressing letters until you press the letter of the command or control that you want to use. In some cases, you 

must first press the letter of the group that contains the command. For example, if the Home tab is active, press ALT+H, 

F, S will take you to the Size list box in the Font group. 

 Note   To cancel the action that you are taking and hide the KeyTips, press ALT. 

Zoom 

To do this Press 

Zoom in. ALT+F6 

Zoom out. ALT+SHIFT+F6 

Fit to window CTRL+SHIFT+W 

Move around in full-screen view 
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Use these keyboard shortcuts to move between Visio and another program or page when you are in full-screen view. 

To do this Press 

Enter full-screen view F5 

Exit full-screen view ESC 

Open the next page in the drawing. PAGE DOWN 

Return to the previous page in the drawing. PAGE UP 

Move around a Web page drawing 

To do this Press 

Cycle the focus through the left frame, the drawing, and shapes on the drawing that contain shape data, 

hyperlinks, and the address bar. 

TAB 

Activate the hyperlink for the shape or hyperlink on the drawing that has focus. ENTER 

 

javascript:ToggleDiv('divExpCollAsst_265621860')
javascript:ToggleDiv('divExpCollAsst_265621860')

